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1. Overview

This software guide applies to Artila’s Matrix-7xx series Industrial loT gateway and
M-A5D35 SoM (System on Module).

*  Operation System
o Linux kernel 5.4.x / 4.19.x
s Supports bootup from eMMC or SD card
= Support Backup/Restore via SD card or USB device
o Boot Loader: Barebox
s File System: EXT4
M-A5D35 uses ETX4 file system for the built-in flash memory disk.
The files system is stored at NAND flash memory.
*  Software Development
s Toolchain: gcc 9.3 /6.2.x + glibc 2.31/2.24
s Supports in-place C/C++ code compilation
» Package Management
o Package repository: Artila self-maintained repository
s Command: Using standard apt-get command
*  Popular Packages
s Web server: Apache/Nginx/Lighttpd
s Database: MySQL/SQLite3/PostgreSQL
s Script Language: PHP/Python/Perl/NodeJS
s Text editor: vim/nano/sed
s Administration: Webmin
*  Protocol Stacks
= IPV4, ICMP, ARP, DHCP, NTP, TCP, UDP, FTP, HTTP, PPP, PPPoE,
CHAP, PAP, SMTP, SNMP V1/V3, SSL, SSH 1/2
» Utilities
= Bash: Shell Command
o Telnet: Telnet client program
o Busybox: Linux utility collection
o FTP: FTP client program
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 Daemon
o pppd: Dial In/out over serial port and PPPoE
s snmpd: SNMP agent program
o inetd: TCP server program
o ftpd: FTP server program
o nginx: Web server program
o sshd: secured shell server
o iptables: Firewall service manager
» Standard Device Drivers
s ttySO0: serial console port (M-A5D35 debug port)
s ttyS1~ttyS4: serial ports (M-A5D35 UARTO~UART3)
s gpio: General Purpose I/O
o mmc: SD/MMC:
s rtc: Real Time Clock
s sda: USB flash memory disk
s ttyACM: USB Modem
s ttyUSB: USB RS-232 adaptor
o spi: spi bus
* 1/O devices Control
M-A5D35 uses standard 1/O device control to access following devices:
o Ethernet: ethO, eth1
s Serial Ports: ttyS1, ttyS2, ttyS3, ttyS4
s Serial Console Port: ttySO
o Real time clock: rtcO
a USB Flash Disk: sda, sda1, sdb, sdb1
s SD memory Card: mmcO
s USB WLAN dongle: wlan0
s USB Serial Cable: ttyUSBO, ttyUSB1
s SPI bus: spi0, spi1
* Default Setting
o |P Default setting:
ethO: DHCP
eth1: 192.168.2.127 (Netmask: 255.255.255.0)
o ssh Login: root
o Password: root
o Terminal type: VT100
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2. Access the USB Serial Console

21 USB Serial Console Introduction

All the M-A5D35 based Matrix loT gateways come with a USB client port (micro-USB
connector), which is used as the serial console. Please prepare a USB-to-microUSB
cable to connect the Matrix 0T gateway to a Desktop/Notebook PC. The Matrix loT
gateway can be directly driven by USB power.

When the Matrix loT gateway finished its boot up process, it will automatically
emulate an USB CDC/ACM compatible serial device.

Use a standard on-the-
shelf USB-to-MicroUSB | Linux/Windows/OSX

cable to connect to the Desktop/Notebook PC
Matrix-7XX

M-A5D35 based
Matrix loT gateway
comes with a USB client port

The identifier name of the CDC/ACM serial port varies depending on your computer’s
operation system and the numbers of the serial ports which are already installed on
your computer.

On Linux system, the serial port name appears like ttyACMO, ttyACM1, etc.

On OSX system, the serial port name appears like tty.usbmodem1421,

tty.usbmodem1422, etc.
On Windows system, the serial port name appears like COM3, COM4, etc.

The serial communication parameters are: 115200, N81, VT100. Use your preferred
serial terminal tools to access the Matrix loT gateway’s serial console.

For example:

On Windows system, use putty or teraterm.

On Linux/OSX system, use minicom utility.

= Note

For Linux, Mac OSX and Windows 10 computers, the CDC/ACM serial driver is
already built-in and will be activated automatically.

For Windows 7/XP computers, it may need to install the CDC/ACM serial driver
manually. Users can download the CDC/ACM driver from Artila web site.
(http://www.artila.com/download/A5D35/Linux/toolchain/linux-cdc-acm.inf).
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2.2 USB Serial Console Log-in

User name: root
Password: root

Following example by Matrix-7XX

Welcome to

* % * % * %
* % * % * %
* % * % * % * %
* % * % * Kk kX * Kk kK * % * % * Kk Kk kKK
* % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK Kk kK
kkkkkkkk kK * % * % * % * % * % * %
* % * % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK kkk

For further information check:
http://www.artila.com/

Poky (Yocto Project Reference Distro) 2.2 matrix710 /dev/ttyGSO
matrix710 login: root

Password:
Welcome to

* % * % * %
* % * % * %
* % * % * % * %
* % * % * Kk kK * Kk kK * % * % * Kk k kKK
* % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK Kk kK
Ak Kk kK kkk kK * % * % * % * % * % * %
* % * % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK Kk kK

For further information check:
http://www.artila.com/

[root@matrix710 ~]#
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3. Network Settings

31 Config the Network Interface
The M-A5D35 based Matrix loT gateways come two Ethernet ports, the default
network settings are shown below:

Ethernet Type | Port Label | Device mapping IP mode IP address
Gigabit GLAN ethO DHCP auto
10/100Mbit LAN eth1 static 192.168.2.127

Users may need to modify the network settings to meet their LAN environment. The
network interface configuration file path is /etc/network/interfaces. Edit and save
the configuration file, then use ifdown and ifup command to ON/OFF the specific

network interface to activate the network settings.

[root@Matrix700 ~]#cat /etc/network/interfaces
# /etc/network/interfaces -- configuration file for ifup(8), ifdown

(8)

# The loopback interface
auto 1lo
iface lo inet loopback

# Wired or wireless interfaces
# Gigabit

auto ethO

iface eth0 inet dhcp

# 10/100M

auto ethl

iface ethl inet static
address 192.168.2.127
netmask 255.255.255.0
network 192.168.2.0
#gateway 192.168.2.1

[root@Matrix700 ~]#

The following screen capture shows the ethO of the Matrix-7xx got a valid IP:

192.168.1.93.

[root@Matrix700 ~]#ifdown ethO

[root@Matrix700 ~]#ifup ethO

udhcpc: option -h NAME is deprecated, use -x hostname:NAME
udhcpc (v1.24.1) started

Sending discover...

Sending select for 192.168.1.93...

Lease of 192.168.1.93 obtained, lease time 86400
/etc/udhcpc.d/50default: Adding DNS 208.67.220.220
/etc/udhcpc.d/50default: Adding DNS 208.67.222.222

[root@Matrix700 ~]#
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3.2  Configure the DNS Server
The DNS configuration file path is /etc/resolv.conf. Users may edit the file according

to their specific network environment.

[root@matrix700 ~]#cat /etc/resolv.conf

[root@matrix700 ~]#ifconfig ethl
ethl Link encap:Ethernet HWaddr 00:13:48:03:08:4a
inet addr:192.168.2.127 Bcast:192.168.2.255 Mask:255.25
5.255.0
inet6 addr: fe80::213:48ff:fe03:84a/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:126 errors:0 dropped:0 overruns:0 frame:0
TX packets:45 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:14966 (14.6 KiB) TX bytes:3770 (3.6 KiB)
Interrupt:41 Base address:0xc000

[root@matrix700 ~]#ping google.com
ping: unknown host google.com

[root@matrix700 ~]#echo 'nameserver 8.8.8.8' > /etc/resolv.conf

[root@matrix700 ~]#cat /etc/resolv.conf
nameserver 8.8.8.8

[root@matrix700 ~]#ping google.com

PING google.com (216.58.200.238) 56(84) bytes of data.

64 bytes from tsa03s0l1-in-f14.1e100.net (216.58.200.238): icmp seg=
1 ttl=52 time

=13.9 ms

64 bytes from tsa03s01-in-£238.1el00.net (216.58.200.238): icmp seq
=2 ttl=52 tim

e=15.3 ms

~C

--- google.com ping statistics ---

2 packets transmitted, 2 received, 0% packet loss, time 1002ms

rtt min/avg/max/mdev = 13.910/14.616/15.322/0.706 ms

[root@matrix700 ~]#

Warning: Please be noted that, the /etc/resolv.conf is physically located in the RAM
disk, so the content of the file will disappear after system reboot.
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4. Access the SSH Console

Most Linux/OSX computers come with built-in SSH client utility. For Windows
users, it is highly recommended to use putty as an SSH client.

User name: root

Password: root

$ ssh root@192.168.1.64

The authenticity of host '192.168.1.64 (192.168.1.64)' can't be est
ablished. ECDSA key fingerprint is SHA256:90090zBGVOF0fZCmP5gLxioRk
bP1RgJIDLnLuklLZVhQ. Are you sure you want to continue connecting (y
es/no)? yes Warning: Permanently added '192.168.1.64' (ECDSA) to th
e list of known hosts. root@192.168.1.64's

password:

Last login: Fri May 6 20:47:14 2016 from 192.168.1.54 Welcome to

* % * % * %
* % * % * %
* % * % * % * %
* % * % * kx Kk x * Kk Kk ok * % * % * kk kKK
* % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK Kk kK
Ak kkkkkk kK * % * % * % * % * % * %
* % * % * % * % * % * % * % * %
* % * % * % * % * % * % Kk k kK Kk kK

For further information check:
http://www.artila.com/

[root@Matrix700 ~]#

]
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5. Check Linux Kernel Version

[root@matrix700 ~]#uname -a
Linux matrix700 4.9.18-yocto-standard #1 Sun Mar 26 23:00:05 CST 20
17 armv7l armv7l armv71l GNU/Linux

[root@matrix700 ~]#uname -v
#1 Sun Mar 26 23:00:05 CST 2017

[root@matrix700 ~]#uname -r
4.9.18-yocto-standard

[root@matrix700 ~]#
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6. File System Information

The M-A5D35 based Matrix loT gateways come with 8GB on-board EMMC Flash
memory, which contains boot loader, Linux kernel, root file system and user disk
(/home).

[root@Matrix700 ~]#1lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
mmcblkO0 179:0 0 7.3G 0 disk
"-mmcblkOpl 179:1 0 7.3G 0 part /
mtdblock0 31:0 0 8.3M 0 disk

mtdblockl 31:1 0 8.2M 0 disk

mtdblock?2 31:2 0 7.7 0 disk

mtdblock3 31:3 0 7.7M 0 disk

mtdblockd 31:4 0 7.eM 0 disk

mtdblock5 31:5 0 3.9 0 disk

[root@Matrix700 ~]#

[root@Matrix700 /]#ls -F
bin/ dev/ home/ lost+found/ mnt/ run/ sys/ usr/
boot/ etc/ 1lib/ media/ proc/ sbin/ tmp@ var/

[root@Matrix700 /1#

[root@Matrix700 ~]#df -h

Filesystem Size Used Avail Use% Mounted on
/dev/root 7.1G 252M 6.5G 4% /

devtmpfs 251M 0 251IM 0% /dev

tmpfs 251M 72K  251M 1% /run

tmpfs 251IM 104K 251M 1% /var/volatile

[root@Matrix700 ~]#
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7. Serial Port Settings

71 Port Mapping

The M-A5D35 based Matrix IoT gateways come with four or eight serial
communication ports. The first four serial ports are CPU native serial ports. Some M-
A5D35 based Matrix loT gateways provide more serial ports via USB-to-Serial chip.
The serial port mapping information is listed below:

Port 1 - /dev/ttyS1

Port 2 > /dev/ttyS2

Port 3 - /dev/ttyS3

Port 4 > /dev/ttyS4

Port 5 - /dev/ttyUSBO

Port 6 > /dev/ttyUSB1

Port 7 - /dev/ttyUSB2

Port 8 > /dev/ttyUSB3

7.2  Configure the Serial Port
Please use the built-in setuart utility to display/modify the operation mode (RS-
232/485) and communication parameters of the first four serial ports (ttyS1/2/3/4).

[root@Matrix700 ~]#setuart -h
Artila utility: setuart
Usage: setuart [OPTION]

-h display this help and exit
-v print version number and exit
-p uart port number
-t uart interface type [232,485]
-b set baudrate, up to 921600bps
Examples:
setuart -p 1 display port 1 type and baudrate

setuart -p 1 -t 485 -b 115200 set port 1 type RS-485 and baud to 115200
setuart -p 1 -t 232 -b 9600 set port 1 type to RS-232 and baud to 9600

= Caution
The serial port’s mode and associated communication parameters will go back to

factory default after system reboot.
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8. System Time and Real-Time Clock(RTC)
8.1 Adjust System Time by data Command

The M-A5D35 based Matrix loT gateways support standard date command to adjust

the Linux system time manually. A typical usage is: date MMDDhhmmYYYY.

[root@Matrix700 ~]#date 050717132016
Sat May 7 17:13:00 UTC 2016

[root@Matrix700 ~]#

8.2  Adjust RTC by hwclock Command

To adjust the on-board Real-time clock (RTC), please follow the steps shown below:
First, to adjust the system time by using the date command. Then use the hwclock
command to synchronize the system time to the RTC.

A typical usage is: hwclock -w.

[root@Matrix700 ~]#hwclock
Thu May 26 15:31:49 2016 0.000000 seconds

[root@Matrix700 ~]#date
Thu May 26 15:32:00 UTC 2016

[root@Matrix700 ~]#hwclock -w

[root@Matrix700 ~]#

8.3 Synchronize System Time by NTP Server

8.3.1 Install the ntpdate utility

The M-A5D35 based Matrix loT gateways support the ntpdate NTP client utility to
synchronize the system date with specified NTP server. Users need to install the

ntpdate utility first by executing the apt-get install ntpdate command.

[root@matrix700 ~]#apt-get install ntpdate
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following NEW packages will be installed:
ntpdate
0 upgraded, 1 newly installed, 0 to remove and 0 not upgraded.
Need to get 0 B/41.0 kB of archives.
After this operation, 0 B of additional disk space will be used.
Selecting previously unselected package ntpdate.

(Reading database ... 17344 files and directories currently install
ed.)
Preparing to unpack .../ntpdate 4.2.8p9-r0 armhf.deb ...

Unpacking ntpdate (4.2.8p9%-r0)
Setting up ntpdate (4.2.8p9%-r0)

[root@matrix700 ~]#
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8.3.2 Using the ntpdate utility
The following example shows how to use the ntpdate utility to synchronize the

system with the NTP server 0.pool.ntp.org.

[root@matrix700 ~]#date
Mon Apr 10 07:17:31 UTC 2017

[root@matrix700 ~]#date 050717132016
Sat May 7 17:13:00 UTC 2016

[root@matrix700 ~]#ntpdate 0.pool.ntp.org
10 Apr 07:18:36 ntpdate[1025]: step time server 61.216.153.106 offs
et 29167497.848661 sec

[root@matrix700 ~]#date
Mon Apr 10 07:18:45 UTC 2017

[root@matrix700 ~]#date;hwclock
Mon Apr 10 07:18:59 UTC 2017
Mon Apr 10 07:18:58 2017 0.000000 seconds

[root@matrix700 ~]#hwclock -w
[root@matrix700 ~]#date;hwclock

Mon Apr 10 07:19:15 UTC 2017
Mon Apr 10 07:19:15 2017 0.000000 seconds

[root@matrix700 ~]#

]
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9. Insert Kernel Modules

Users can use command Ismod to list all installed kernel modules.

[root@matrix700 rc5.d]#lsmod

Module Size Used by

usb f mass storage 25809 2

usb f acm 4064 2

u serial 7750 3 usb f acm

libcomposite 33643 12 usb_f acm,usb f mass storage
nfsd 251055 11

auth rpcgss 39359 1 nfsd

oid registry 2441 1 auth rpcgss

exportfs 3541 1 nfsd

nfs acl 2510 1 nfsd

lockd 53405 1 nfsd

grace 1627 2 nfsd,lockd

sunrpc 175725 16 auth rpcgss,nfsd,nfs acl, lockd
atmel usba udc 15098 O

udc_core 10846 5 usb f acm,usb f mass storage,atmel
usba udc,u serial,libcomposite

To load additional kernel modules during the system boot-up, you can modify the file:
/etc/modules.

[root@Matrix700 ~]#cat /etc/modules
atmel usba udc

#g_serial

#mt7601Usta

[root@Matrix700 ~]#
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10. Insert Software Package

The M-A5D35 based Matrix IoT gateways support standard apt (Advanced Package
Tool) package management utility. With this utility, users can easily install, upgrade,
remove software packages. Artila provides a self-maintained software repository. The

apt configuration file path is /etc/apt/sources.list.

[root@Matrix700 ~]#ls /etc/apt
apt.conf apt.conf.d preferences.d sources.list sources.list.d

[root@Matrix700 ~]f#cat /etc/apt/sources.list
deb [trusted=yes] http://www.artila.com/download/A5D35/Linux/deb/co

rtexabhf-vfp cortexabhf-vfp main
deb [trusted=yes] http://www.artila.com/download/A5D35/Linux/deb/al

1 all main
deb [trusted=yes] http://www.artila.com/download/A5D35/Linux/deb/ma

trix700 matrix700 main

** Please be noted the last line of the /etc/apt/sources.list varies according to

specific model name.

Commonly used apt commands are listed below:

* apt-get install <package> to install package

* apt-get remove <package> to remove package

* apt-cache search <package> to search package
* apt-get update to update the package list

* apt-get upgrade to upgrade installed packages

]
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11. Mount/Unmount an SD Card

The M-A5D35 based Matrix lIoT gateways support SD card access. If an SD card is
inserted, you can use Isblk command to find the device identifier name. And then
use mount command to mount the SD card to a folder.

Before SD Insertion

[root@Matrix700 ~]#1lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
mmcblkO0 179:0 0 7.3G 0 disk
"-mmcblkOpl 179:1 0 7.3G 0 part /
mtdblockO 31:0 0 8.3M 0 disk
mtdblockl 31:1 0 8.2M 0 disk
mtdblock?2 31:2 0 7.7 0 disk
mtdblock3 31:3 0 7.7M 0 disk
mtdblock4 31:4 0 7.6M 0 disk
mtdblock5 31:5 0 3.9M 0 disk
After SD Insertion

[root@Matrix700 ~]#lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
mmcblkO0 179:0 0 7.3G 0 disk
"-mmcblkOpl 179:1 0 7.3G 0 part /
mmcblkl 179:24 0 1.9G 0 disk
mtdblockO 31:0 0 8.3M 0 disk
mtdblockl 31:1 0 8.2M 0 disk
mtdblock?2 31:2 0 7.7 0 disk
mtdblock3 31:3 0 7.7M 0 disk
mtdblock4 31:4 0 7.6M 0 disk
mtdblock5 31:5 0 3.9M 0 disk

Mount mmcblk1 to /media.

[root@Matrix700 ~]#mount /dev/mmcblkl /media
[root@Matrix700 ~]#lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
mmcb1lk0 179:0 0 7.3G 0 disk
“-mmcblkOpl 179:1 0 7.3G 0 part /
mmcblkl 179:24 0 1.9G 0 disk /media
mtdblock0 31:0 0 8.3M 0 disk
mtdblockl 31:1 0 8.2M 0 disk
mtdblock?2 31:2 0O 7.7M 0 disk
mtdblock3 31:3 0O 7.7M 0 disk
mtdblock4 31:4 0O 7.oM 0 disk
mtdblock5 31:5 0 3.9M 0 disk

Unmount /media.
[root@Matrix700 ~]#umount /media
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12. Mount/Unmount a USB Card

The M-A5D35 based Matrix IoT gateways support generic USB drives. If an USB
drive is inserted, you can use Isblk command to find the device identifier name. And
then use mount command to mount the USB drive to a folder.

Before USB drive Insertion

[root@Matrix700 ~]#1lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
mmcblk0 179:0 0 7.3G 0 disk
"-mmcblkOpl 179:1 0 7.3G 0 part /
mtdblockO 31:0 0 8.3M 0 disk
mtdblockl 31:1 0 8.2M 0 disk
mtdblock?2 31:2 0 7.7 0 disk
mtdblock3 31:3 0 7.7M 0 disk
mtdblock4 31:4 0 7.6M 0 disk
mtdblock5 31:5 0 3.9M 0 disk
After USB drive Insertion

[root@Matrix700 ~]#1lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
sda 8:0 1 14.5G 0 disk
‘-sdal 8:1 1 14.5G 0 part
mmcb1lk0 179:0 0 7.3G 0 disk
"-mmcblkOpl 179:1 0 7.3G 0 part /
mtdblockO 31:0 0 8.3M 0 disk
mtdblockl 31:1 0 8.2M 0 disk
mtdblock?2 31:2 0 7.7 0 disk
mtdblock3 31:3 0 7.7M 0 disk
mtdblock4 31:4 0 7.6M 0 disk
mtdblock5 31:5 0 3.9M 0 disk

Mount sda1 to /media.

[root@Matrix700 ~]#mount /dev/sdal /media
[root@Matrix700 ~]#lsblk

NAME MAJ:MIN RM SIZE RO TYPE MOUNTPOINT
sda 8:0 1 14.5G 0 disk

‘-sdal 8:1 1 14.5G 0 part /media
mmcb1lk0 179:0 0 7.3G 0 disk
"-mmcblkOpl 179:1 0 7.3G 0 part /
mtdblockO 31:0 0 8.3M 0 disk
mtdblockl 31:1 0 8.2M 0 disk
mtdblock?2 31:2 0O 7.7M 0 disk
mtdblock3 31:3 0O 7.7M 0 disk
mtdblock4 31:4 0O 7.oM 0 disk
mtdblock5 31:5 0 3.9M 0 disk

Unmount /media.
[root@Matrix700 ~]#umount /media
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13. Web Server Settings

13.1  Nginx Web Server
The M-A5D35 based Matrix loT gateways come with pre-installed nginx web server.
The configuration file is /etc/nginx/nginx.conf.

w 1 _ ==
' [ Welcome to nginx! SN W ————S————— ]
& C M 11921682127 Bhor =

Welcome to nginx!

If you see this page, the nginx web server is successfully installed and
working. Further configuration is required.

For online documentation and support please refer to nginx.org.
Commercial support is available at nginx.com.

Thank you far using nginx. b

13.2 Root Web Page Directory
The default root web page directory is /var/iwww/localhost/html. This path can be
changed by modifying the above configuration file.

[root@Matrix700 ~]#l1ls /var/www/localhost/html
50x.html index.html

[root@Matrix700 ~]#

]
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13.3 PHP Support

The M-A5D35 based Matrix loT gateways support commonly used server-side script
languages, including Perl, PHP and Python. Per and Python support are built-in,
while PHP support needs to be installed manually using apt-get command.

® apt-getinstall php-cli

® apt-getinstall php-cgi

® apt-getinstall php-fom

[root@matrix700 ~]#php-cgi -v

PHP 5.6.26 (cgi-fcgi) (built: Mar 19 2017 01:15:26)

Copyright (c) 1997-2016 The PHP Group

Zend Engine v2.6.0, Copyright (c) 1998-2016 Zend Technologies

[root@matrix700 ~]#php-fpm -v

PHP 5.6.26 (fpm-fcgi) (built: Mar 19 2017 01:15:19)

Copyright (c) 1997-2016 The PHP Group

Zend Engine v2.6.0, Copyright (c) 1998-2016 Zend Technologies

[root@matrix700 ~]#php -v

PHP 5.6.26 (cli) (built: Mar 19 2017 01:15:12)

Copyright (c) 1997-2016 The PHP Group

Zend Engine v2.6.0, Copyright (c) 1998-2016 Zend Technologies

[root@matrix700 ~]#

]
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14. Auto-execute User Applications/Shell Scripts

141  Modify the /etc/rc5.d directory
To automatically start user applications after system boot-up, please edit a shell
script to execute the program, and put that script file to the folder: /etc/rc5.d.

[root@matrix700 rc5.d]#1s

SO0lnetworkingd S19nfscommond S60php-fpmd S99stop-bootlogd
@

S02dbus-1@ S20atda S90crond@ S99%usbgadget@
S09sshdd S20hwclock.sh@ S92nginx@ S99%webmin@
S12rpcbind@ S20nfsserver(@ S99readyled@

Slbmountnfs.sh@ S20syslogQ@ S99rmnologin.sh@

[root@matrix700 rc5.d]#

14.2 Modify the /etc/profile
To automatically start user shell scripts after system boot-up, please modify the
/etc/profile accordingly.

]
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15. Change the Welcome Message

The welcome message file is /etc/motd, the default content is shown below, modify
the content at your will.

[root@Matrix700 ~]#cat /etc/motd
Welcome to

* % * % * %
* % * % * %
* % * % * % * %
* % * % * Kk k% * Kk k% * % * % * Kk k kKK
* % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK Kk kK
Ak Kk kK kkk kK * % * % * % * % * % * %
* % * % * % * % * % * % * % * %
* % * % * % * % * % * % Ak Kk kK Kk kK

For further information check:
http://www.artila.com/

[root@Matrix700 ~]#
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16. Reboot the System

To re-boot the system, use the reboot command.

[root@Matrix700 ~]#reboot

Broadcast message from root@Matrix700 (ttyGS0) (Sun May 8 15:51:47
2016) :
The system is going down for reboot NOW!
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17. User Application Development

17.1 Install C/C++ Cross Compilation Toolchain
The following instructions are based on 64-bit Ubuntu Linux environment:

Step 1, Download the toolchain installation script from Artila’s website, the URL is:
$wget http://www.artila.com/download/samab/linux/deb/sdk/poky-glibc-x86_64-meta-

toolchain-cortexabt2hf-vfp-m-a501-toolchain-3.1.1.sh

Step 2, Execute the toolchain installation script.
$ sh poky-glibc-x86_64-artila-full-cmdline-cortexa5hf-vfp-toolchain-3.1.1sh
Step 3, Activate the environment settings.
$ source /opt/poky/3.1.1/environment-setup-cortexa5hf-vfp-poky-linux-
gnueabi

17.2 Using the C Cross Compiler

Step 1: Execute $€CC command to compile the C source file.

Step 2: Execute scp command to upload the compiled binary file to the Matrix loT
gateway.

$ cat hello.c
#include <stdio.h>

int main () {
printf ("Hello World!\n");
return 0;

}
$ SCC -o hello c¢c hello.c

$ scp hello ¢ root@192.168.1.70:/home/root

root@192.168.1.70's password:

hello c 100% 9800 9.6KB/s
00:00

e
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17.3 Using the C++ Cross Compiler

Step 1: Execute $CXX command to compile the C++ source file.

Step 2: Execute scp command to upload the compiled binary to the Matrix IoT
gateway.

$ cat hello.cpp

#include <iostream>

using namespace std;

int main () {

cout << "Hello! World!\n";
return 0;

}
$ SCXX -o hello cpp hello.cpp

$ scp hello cpp root@192.168.1.70:/home/root

root@192.168.1.70's password:

hello cpp 100% 11KB 10.9KB/s
00:00

17.4 Using the Native C Compiler

User application can also be directly developed on the M-A5D35 based Matrix 0T
gateways. By default, gcc toolchain is pre-installed on the M-A5D35 based Matrix
loT gateways.

[root@Matrix700 ~]#cat hello.c
#include <stdio.h>

int main ()

{

printf ("Hello World!\n");

}

[root@Matrix700 ~]#gec -o hello hello.c

[root@Matrix700 ~]#./hello
Hello World!

[root@Matrix700 ~]#
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17.5 Using the Native C++ Compiler

17.5.1 Install the Native C++ Toolchain

Users can install the native C++ toolchain via apt-get command. Two packages are
needed to build a C++ source file, the g++ package and the g++-symlinks package.
* apt-get install g++ g++-symlinks

17.5.2 Using the Native C++ Compiler

[root@Matrix700 ~]#cat hello.cpp
#include <iostream>

using namespace std;

int main () {

cout << "Hello World!\n";

return 0;

}

[root@Matrix700 ~]#g++ -o hello cpp hello.cpp

[root@Matrix700 ~]#./hello cpp
Hello World!

[root@Matrix700 ~]#

]
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17.6 Using the Python Interpreter
17.6.1 Python 2 Support
The M-A5D35 based Matrix loT gateways come with pre-built Python 2.7 interpreter.

[root@matrix700 ~]#python

Python 2.7.12 (default, Mar 19 2017, 00:10:10)

[GCC 6.2.0] on linux2

Type "help", "copyright", "credits" or "license" for more informati
on.

>>>

The Python pip package manager is also included by default. To upgrade the pip
itself, execute the following command:
* pip install —upgrade pip

17.6.2 Python 3 Support

Users can also install Python 3 via the apt-get command.
* apt-get install python3-core

* apt-get install python3-pip

* touch /user/lib/python3.5/site-packages/easy-install.pth
e pip3install --upgrade pip

[root@matrix700 ~]#python3

Python 3.5.2 (default, Mar 19 2017, 01:00:38)

[GCC 6.2.0] on linux

Type "help", "copyright", "credits" or "license" for more informati
on.

>>>

[root@matrix700 site-packages]#pip list --format=columns
Package Version

pip 9.0.1

setuptools 22.0.5
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18. GPIO Operation

The M-A5D35 SoM comes a bunch of GPIO (General Purpose 10) pins.
By implementation, all M-A5D35’s GPIO pins are controlled in user space.
The M-A5D35 CPU provides five banks of GPIOs shown as below:

GPIO Bank Bank A Bank B Bank C Bank D Bank E
GPIO label PAO-31 PBO0-31 PCO0-31 PDO0-31 PEO-31
GPIO chip gpiochip0 | gpiochip32 | gpiochip64 | gpiochip96 | gpiochip128
GPIO number 0-31 31-63 64-95 96-127 128-159
GPIO mapping | pioA0-31 | pioB0-31 pioCO0-31 pioD0-31 pioE0-31

For example, the GPIO PA31, which is located on the pin43 of the CN1 connector, is
mapped to number 31 (31 =0 + 31); the GPIO PD30, which is located on the pin45
of the CN1 connector, is mapped to number 126 (126 = 96 + 30).

Example 1, to set PA31 as output:
[root@matrix700 ~]#cd /sys/class/gpio/

[root@matrix700 gpio]l#ls
export gpiochip0 gpiochipl28 gpiochip32 gpiochip64 gpiochip96
unexport

[root@matrix700 gpio]l#echo 31 > export

[root@matrix700 gpio]l#ls

export gpiochipl28 gpiochip64 pioA3l
gpiochip0 gpiochip32 gpiochip96 unexport
[root@matrix700 gpio]l#cd pioA3l

[root@matrix700 pioA31]#ls

active low device direction edge power value

subsystem uevent

[root@matrix700 pioA31l]#echo 'out' > direction
[root@matrix700 pioA3l]#echo 1 > value
[root@matrix700 pioA31l]l#echo 0 > value
[root@matrix700 pioA31]#cd ..

[root@matrix700 gpio]l#ls

export gpiochipl28 gpiochip64 pioA31l
gpiochip0 gpiochip32 gpiochip96 unexport
[root@matrix700 gpio]l#echo 31 > unexport
[root@matrix700 gpio]l#ls

export gpiochip0 gpiochipl28 gpiochip32 gpiochip64 gpiochip96
unexport

[root@matrix700 gpiol#

]
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Example 2, to set PD30 as output:

[root@matrix700 gpio]#pwd
/sys/class/gpio

[root@matrix700 gpio]l#ls

export gpiochip0 gpiochipl28 gpiochip32 gpiochip64 gpiochip96
unexport

[root@matrix700 gpio]l#echo 126 > export

[root@matrix700 gpio]l#ls

export gpiochipl28 gpiochip64 pioD30

gpiochipO0 gpiochip32 gpiochip96 unexport

[root@matrix700 gpio]l#cd pioD30

[root@matrix700 pioD30]#1ls
active low device direction edge power subsystem uevent value

[root@matrix700 pioD30]#echo 'out' > direction
[root@matrix700 pioD30]#echo 1 > value
[root@matrix700 pioD30]#echo 0 > value
[root@matrix700 pioD30]#cd ..

[root@matrix700 gpio]l#ls

export gpiochipl28 gpiochip64 pioD30
gpiochipO0 gpiochip32 gpiochip96 unexport
[root@matrix700 gpio]l#echo 126 > unexport
[root@matrix700 gpio]l#ls

export gpiochip0 gpiochipl28 gpiochip32 gpiochip64 gpiochip96
unexport

[root@matrix700 gpiol#

For more detailed information please refer to
https://www.kernel.org/doc/Documentation/gpio/sysfs.txt.

]
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19. Install an USB Wi-Fi Dongle

The M-A5D35 based Matrix IoT gateways support USB Wi-Fi dongles. Current driver
supports RT8192/RT5390 compatible hardware (e.g. ASUS USB-N10 Nano
Wireless-N or WPER-172GN).

19.1 Install Hardware Driver
The USB Wi-Fi driver can be installed via apt-get utility.

[root@Matrix700 ~]#apt-get install kernel-module-rtl8xxxu linux-fir
mware-rtl8192cu

Install RT5390 driver via apt-get utility

[root@Matrix700 ~]#apt-get install kernel-module-rt2800usb linux-fi
rmware-ralink

19.2 Modify the network interface configuration
The network interface configuration file path is /etc/network/interfaces. A typical

configuration example is listed below:

# Wireless interfaces
auto wlanO
iface wlan0O inet dhcp
wireless mode managed
wireless essid any
wpa-driver nl80211, wext
wpa-conf /etc/wpa supplicant.conf

Be noted the last line of the above example, which specifies an additional
configuration file for WPA settings. In this example, the WPA configuration file path is
/etc/wpa_supplicant.conf.
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19.3 Modify the WPA configuration
Modify the /etc/wpa_supplicant.conf according to the Wi-Fi environment of your

factory/office. A typical configuration example is listed below:
# WPA configuration

ctrl interface=/var/run/wpa_ supplicant
ctrl interface group=0

update config=1

ap_scan=1

# WEP example
network={

ssid="Artila”

key mgmt=NONE

wep keyO=ABCABCABC
}

# WPA/WPA2 example

Network={
ssid="Artila”
key mgmt=WPA-PSK
auth alg=O0PEN
psk="ABCABCABC”

19.4 Restart the wireless network interface
[root@Matrix700 ~]#ifdown wlanO

[root@Matrix700 ~]#ifup wlanO

]
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20. Webmin Support

The M-A5D35 based Matrix loT gateways support the Webmin, which is a
browser_based system management tool.

To access the Webmin, please visit https://192.168.2.127:10000,
Username: admin

Password: admin

&) webmin
Version 1750 én javis (Poky (Yocto Project Reference Distro) 1.8.1)

(Wb System  [Networkiig® Hardwire

L] »/ ) Nl
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21. Setup Eclipse IDE

Users can integrate the M-A5D35 tool chain into the Eclipse IDE. It can be
downloaded the Eclipse IDE for C/C++ Developers (Luna) from

https://www.eclipse.org/downloads/packages/release/Luna/SR2

211 Configure the Eclipse IDE
Step 1, Start the Eclipse IDE.
Step 2, From “Help” menu select “Install New Software”

> Add “Luna - http://download.eclipse.org/releases/luna”.

» Select the following items (If these selections do not appear in the list, that
means the items are already installed.)
B Linux Tools
® Linux Tools LTTng Tracer Control
® Linux Tools LTTng Userspace Analysis
® | TTng Kernel Analysis
B Mobile and Device Development
® C/C++ Remote Launch (Requires RSE Remote System Explorer)
Remote System Explorer End-user Runtime
Remote System Explorer User Actions
Target Management Terminal (Core SDK)

TCF Remote System Explorer add-in
® TCF Target Explorer

B Programming Languages
® C/C++ Autotools Support
® C/C++ Development Tools

]
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Step3, Complete the installation and restart the Eclipse IDE

Dynamic Help
Key Assist., ShiftCrrbL
Tips and Tricks...

& Report Bug or Enhancement...

—— % Check for Updates.
W install New Software, . e

‘o]
§n~m
i

] o m““":: m‘
© About Eclipse

i
:
i

Available Software
Check the items that you wish to install.

type filter text

Name

» [] 000 General Purpose Tools

» [] 000 Linux Tools

» [] 000 Mobile and Device Development
» [ 000 Modeling

» (] 000 Programming Languages
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21.2 Install the Eclipse Yocto Plug-in

Step1, From the “Help” menu select “Install New Software”
» Add URL “http://downloads.yoctoproject.org/releases/eclipse-
plugin/2.0/luna” and provide a meaningful name.

» Select the following items
® Yocto Project ADT Plug-in,
® Yocto Project Bitbake Commander Plug-in
® Yocto Project Documentation plug-in.
Step2, Complete the installation and restart the Eclipse IDE

N Install + X
Available Software ]
Check the items that you wish to install. \;_,)f
L\ (10371l Y octo Plug-in - http://downloads.yoctoproject.org/releases/eclipse-plugin/2.0/luna) v | Add...
Find more software by working with the "Available Software Sites" pi es.
[:y;w filter text al
Name Version

» [ 000 Yocto Project ADT Plug-in
» 000 Yocto Project Bitbake Commander Plug-in

& 11 Yocto Project Documentation plug-in

———
| DeselectAll | 4items selected

Details
Yocto Project Documentation plug-in 1.0.0.277-cKISVE7735C55375E75

(v Show only the latest versions of available software v/ Hide items that are already installed
[V Group items by category What s already installed?

[*) Show only software applicable to target environment

[ Contact all update sites during install to find required software

@ Back Next > Cancel Finish

]
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21.3 Configuring the Cross-Compiler Options

Step1, From the “Windows” menu select “Preferences”
Step2, Click "Yocto Project ADT" to display the configuration screen
Step3, Selecting the Toolchain Type: Standalone pre-built toolchain
»  Point to the Toolchain: /opt/poky/3.1.1
»  Specify the Sysroot Location: /opt/poky/3.1.1/sysroots
»  Select the Target Architecture: cortexa5hf-vfp-poky-linux-gnueabi

Tv C/C#+ - Eclipse & - X
Fle Edit Source Refactor Navigate Search Projsct YoctoProjectiools Run Target Help
@ welcome 22 New Window 5
Editor
Welcome to the Eclipse IDE for C/C++ Developers =
Show Toolbar
Qpen Perspective

Show View

Customize Perspective...
Save Perspective As..

P Reset Perspectiva.. A
- 2 Clase Perspective
Close All Perspectives

Nawigation

Overview Tutorials S New
Preferences
Woarkbench
v Preferences + X |
(type filter text q] (@ Please apply the changes to revalidate. =1 v w
>
General Cross development profiles:
Sl Standard Profil
tandard Profile - | |Save as...| |[Rename
Changelog l J ‘—J =
Createrepo Remove
> Hel . .
P Cross Compiler Options:
> Install/Update
ke o) Standalone pre-built toolchain
> Library Hover
(O Build system derived toolchain
Man pages
> Mylyn Toolchain Root Location: [/opt/pokyla.l.l || Browse.
» Remote Development
» Remote Systems Sysroot Location: I/Opl/pOk)’/3.1.1/SySfOOtS| l | Browse.. |
» Run/Debu . > 5
9 Target Architecture: | cortexaShf-vfp-poky-linux-gnueabi =)
> Specfile Editor
> SystemTap Target Options:
> Target Explorer O QEMU
> Team ]
Kernel: Browse..
Terminal
> Tracing Custom Option:
Yocto Project ADT
(o) External HW
|Restore Defaults I | Apply |
[ E—T)
@ =
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21.4 Create a Hello World Project

Step1, Select "Project" from the "File -> New" menu
» Double click C/C++
» Double click C Project to create the project
» Expand Yocto Project ADT Autotools Project
select Hello World ANSI C Autotools Project.
(This is an Autotools-based project based on a Yocto template)
» Putaname in the Project name field.
(Do not use hyphens as part of the name)
»  Click "Next".
Add information in the Author and Copyright notice fields.
»  Click "Finish".

Y

Step2, Right-click in the navigation pane and select "Reconfigure Project" from the
pop-up menu. This selection reconfigures the project by running autogen.sh in
the workspace for your project.

]
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Step3, To build the project select "Build Project" from the "Project” menu.

&) Convert to a C/C++ Autotools Project
Lyl Save Crles.
W svens ] Convert to a C/C++ Project (Adds C/C++ Nature)
I Save Al ShiftsCrieS & N
9 Folder
Revert 3 .
& source File ¢
Mos... K] Header File
! Rename.. "\ [Y File from Template
o Refresh | @ Class. S
Convert Line Delimiters To * | (F Task
5Pk C11+ 9 ther.. Cren
Switch Workspace 0
Restart
24 Import...
i Export..
Waorkbench
Properties AltsEnter
Exit

C Project
Project name must be specified

> (= GNU Autotools
¥ (& Yocto Project ADT Autotools Project
@ Empty C Autotools Project

Hello Worlc SICAu

@ Hello World GTK C Autotools Project
V (= Executable

@ Empty Project

@ Hello World ANSI C Project
» (= Shared Library
[
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- XK Delete Delete pst/sreHelloCTestc - Eclipse = _# X
File Edit Remove from Context Tools Run Target Window Help
N Source ’ (3 2 B 0 TargetProfiles v | B R
g > & Move v & & mifl = etaaw e
Rel FZ i
i | Quick Actess :| o5 m
= !u Import...
C ngectE:wlurx_;.__l B T a =
| tila copyright.[] -
\  Build Project &
Clean Project ®
> i
¥ ——
v @i o Profect World abc*); /= prints Hello World =/ :
| Close Unrelated Projects =
» [ Helloc| Y
» 35 Helloc|  Build Configurations '
» E)Helloc|  Make Targets '
[ Makefj  Index ¥ i
|
Makefi S 5
i Makefl  poconfigure Project li— bl 5 [Tl Properties Wi Call Grag =
BMake 1 otools ' . T
(= automate bvn & &R &R 2B+~
maclbcam!' Show in Remote Systems view
| DTy mOmE U S WOT KSPEUE; HELLOLTES L STL
8 arm-poky  Frofiing Tools 'lecc -marchearmy7-a -marm -mthumb-interwork -mfloat-abishard -mi
. Profile As » elloCTest.Tpo .deps/HelloCTest-HelloCTest.Po
i-libtool --tag=CC --mode=Llink arm-poky-linux-gnueabi-gcc -r
Debug As * libtool: link: arm-poky-linux-gnueabi-gce -march-armv7-a -marm -r
Bun As » |ry ‘/home/uj/workspace/HelloCTest/src’
ory */home/uj/workspace/HelloCTest"
Compare With *|ry '/home/uj/workspace/HelloCTest'
Restore from Local History... ry '/home/uj/workspace/HelloCTest’
Run §/C++ Code Analysis {took 512ms)
=" Team '
S C/C++- HelloCTest/src/HelloCTest.c - Eclipse - & X
File Edit Source Refactor Navigate ’Seirth Project YoctoProjectTools Run Target Window Help
(v il & B v & v (a8 NewConnection.. fe s Eries @iginvigrEarBye-
: s H 5 I {
:#vainQv:@@@v“@ml |y &l vt G v - Quick Access :}Qm
[ Project Explorer X = B [g HelloCTestc R = |
B & 2& * Copyright (C) Artila copyright.[]
il “ | 3 8=
> 4 Binaries 32 #include <stdio.h>
> ) Includes 34-int main(void) {
= 35 puts(“Hello World abcl'); /* prints Hello World */
B sre 36 return 0;
> [g) HelloCTest.c 37 }
» 35 HelloCTest - [arm/le] =
» [ HelloCTest-HelloCTest.o- [a
[® Makefile
| Makefile.am C >
i Makefilein §2 Problems &) Tasks (B Console 2 |1 =8
> (= automdte.cache 2
mem U B eB-R 8-~

[2 arm-poky-linux-gnueabi-libtool
AUTHORS

autogen.sh

ChangeLog

[# compile

[# config.guess

configh

[ config.h.in

[=Y

ronfin lnn

CDT Build Console [HelloCTest]

MAKELZ): ENLEILNY ULIECLOTY  /MNOME/UJ/WOT KSPACE/HELLOLIES L/ STC
arm-poky-linux-gnueabi-gcc -march=armv7-a -marm -mthumb-interwork -mfloat-abi=hard -mi
mv -f .deps/HelloCTest-HelloCTest.Tpo .deps/HelloCTest-HelloCTest.Po
../arm-poky-linux-gnueabi-libtool --tag=CC --mode=link arm-poky-linux-gnueabi-gcc -n
arm-poky-linux-gnueabi-libtool: link: arm-poky-linux-gnueabi-gcc -march=armv7-a -marm -n
make[2]: Leaving directory '/home/uj/workspace/HelloCTest/src'

make[2]: Entering directory '/home/uj/workspace/HelloCTest"

make[2]: Leaving directory '/home/uj/workspace/HelloCTest"

make[1]: Leaving directory '/home/uj/workspace/HelloCTest"

23:12:04 Build Finished (took 512ms)

>

Writable SmartInsert  35:30
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22. Setup miniPCle (mPCle) Power

The M-A5D35 based Matrix lIoT gateways, Model Matrix-710 & 713, support the
miniPCle slot can be install LTE/4G/3G/WiFi .... module for wireless communication.

Following information shows how to turn on/off mPCle power (GPIO: PA2, PA3)

Example 1, Turn on of mPCle A (Matrix-713)
echo 2 > /sys/class/gpio/export
echo out > /sys/class/gpio/pioA2/direction
echo 0 > /sys/class/gpio/pioA2/value

Example 2, Turn off of mPCle A (Matrix-713)
echo 1 > /sys/class/gpio/pioA2/value
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23. Setup SIM card

The M-A5D35 based Matrix lIoT gateways, Model Matrix-710 & 713, support the
miniPCle slot can be install LTE/4G/3G module for communication.
SIM Card setting is necessary before access by following:

NOTICE: Please unlock SIM PIN code first

Example: RYH2708

apt-get install kernel-module-cdc-acm kernel-module-pppoe kernel-module-ppp-
mppe kernel-module-ppp-async ppp

configure /etc/ppp/peers/3g

/dev/ttyACM2 # modem port used

460800 # speed

defaultroute # use the cellular network for the default route
replacedefaultroute

noipdefault

usepeerdns # use the DNS servers from the remote network
#nodetach # keep pppd in the foreground

#nocrtscts # hardware flow control

#lock # lock the serial port

#noauth # don't expect the modem to authenticate itself
#local # don't use Carrier Detect or Data Terminal Ready
#persist

#demand

modem

#debug

# Use the next two lines if you receive the dreaded messages:

No response to n echo-requests
Serial link appears to be disconnected.
Connection terminated.

H= o e o e

lcp-echo-failure 4

lcp-echo-interval 65535

connect "chat -v -f /etc/ppp/chats/connect"
disconnect "chat -v -f /etc/ppp/chats/disconnect”
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/etc/ppp/chats/connect

TIMEOUT 10

ABORT 'BUSY'

ABORT 'NO ANSWER'

# ABORT 'ERROR'

SAY 'Starting 3G connect scripti\n'

Fom "AT+CPIN="0000""
# Get the modem's attention and reset it.
mn 'ATZ'

# E0=No echo, V1=English result codes

#OK 'ATQ0 V1 E1 S0=0 &Cl &C2 +FCLASS=0'
#0OK 'ATQ0 V1 E1 &Cl &C2 '
OK 'ATQO"

# Set Access Point Name (APN)
OK 'AT+CGDCONT=1, "IP", "internet"'

# Dial the number
ABORT 'NO CARRIER'

SAY 'Dialing...\n'
OK "ATDT*994#"'
CONNECT ''

/etc/ppp/chats/disconnect

mwn " \K"

mn 'l+++ATHO"
SAY "GPRS disconnected."

/etc/network/interfaces

# 3G PPP interface
#
# Example of a 3G ppp connection
#
auto pppo
iface ppp0 inet ppp
provider 3g
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Matrix-713 support Dual micro-SIM (GPIO: PA21) which Support cross-zone
communication / seamless integration or dual-SIM for dual-LTE/4G/3G mPCle

module.

Dual SIM Ctrl
Import notes:
If config is change which restart the mPCle power after.

Default: *

SIM_SW | mPCle A | mPCle B
*0 | SIMA | SIMB
1 | SIMA | NA

Example: Turn on and set 0
echo 21 > /sys/class/gpio/export
echo out > /sys/class/gpio/pioA2/direction
echo 0 > /sys/class/gpio/pioA2/value
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24. Setup “STATUS” LED indicator

The M-A5D35 based Matrix loT gateways, Model Matrix-713, support three
“STATUS” LED indicators for user definition control by GPIO: A22, A23, A26

Example 1, Enable and turn on the LED1
echo 22 > /sys/class/gpio/export
echo out > /sys/class/gpio/pioA22/direction
echo 0 > /sys/class/gpio/pioA22/value

Example 2, Turn off and disable the LED1
echo 1 > /sys/class/gpio/pioA22/value
echo 22 > /sys/class/gpio/unexport
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25. Setup Digital Input / Digital Output

The M-A5D35 based Matrix loT gateways, Model Matrix-713, support 2x digital input
and 2x digital output port.

DI / Digital Input (GP10O: D7, D21)
DO / Digital Output (GPIO: D19, D20)

Example 1, Read value of DI1
cat /gpio/Dl1/value

Example 2, Set High of DO1
echo 0 > /gpio/DO1/value
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26. Setup GNSS & IMU

The M-A5D35 based Matrix loT gateways, Model Matrix-713, support GNSS and
IMU as following:

GNSS (Global Navigation Satellite System)
Support Dual Satellite: GPS & GLONASS

Command: gpsmon

IMU (Inertial Measurement Unit)
1 x 3-Axis digital output Gyroscope
Command: iio_info
1 x 3-Axis Accelerometer (G-Sensor)
Command: iio_info
1 x 3-Axis Magnetometer (E-Compass)
Command: apt-get install i2c-tools

i2cdump -y 3 0x0c

]
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27. Setup Audio Out

The M-A5D35 based Matrix loT gateways, Model Matrix-713, support one Audio out
as line-out R/L port, optional earphone R/L.

Command: aplay (support format type: voc, wav, raw or au)

Example: aplay sample.wav
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28. Restore to Factory Default

The following information shows how to restore to factory default:

Step 1,

Power-on Matrix-700 (“Ready” LED in green)

After system ready (“Ready” LED turns to yellow),
Connect the Matrix-700’s USB/serial console to a PC

mAaTRIX’

TeraTerm Terminal Emulator

Step 2,
It shows USB Serial Device “COMXx" at Device Manager / PC Windows:
X : depends on your PC’s environment

4 Device Manager = o X
Ele  Action View Help
s mEmE
@ Batteries a
© Bluetooth
B8 Computer
«n Disk drives
§ Dusplay adapters
@ Ellisys protocol analyzers
% Human Interface Devices
9 IDE ATA/ATAP! controllers
2 Imaging devices
@ Intel(R) Dynamic Platform and Thermal Framework
@ Jungo Connectivity
2 Keyboards
@ Mice and cther pointing devices
B8 Monttors
@ Network adapters
B Portable Devices
v @ Ports (COM&LPT)
@ Communications Port (COM1)
P ECP Printer Port (LPTY)
Lok COCUART Pog (COM
USe Port (COMY
7= Prnt queves
7= Printers
O Processors
B Ghrars Amnsne

<: New connected
Device

Communicate via this Serial device (EX. By TeraTerm @115200,N81).

]
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Step 3,
Execute the command “restore factory” and “y”, this command will force Matrix-

700/710/713 to boot again to start the restore process.

# restore factory
Restore from factory, Sure?(y/n)

The READY LED will be blinking during the restore process
This process may take 20~30minutes.
USB/serial console is NOT accessible during the restore process.

WATIE

After completed above steps, the Matrix-700/710/713 will automatically reboot again
when the backup process is finished.
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29. Backup the “File System” of Matrix-700/710/713

The following information shows how to restore to factory default:

Step 1,
Insert an empty 16GB(or above) USB drive (FAT32 format). Let’s say the USB drive
maps to /dev/sda1.

Step 2,

Power-on Matrix-700/710/713 (“Ready” LED in green)

After system ready (“Ready” LED turns to yellow),

Connect the Matrix-700/710/713’s USB/serial console to a PC

mAaTRIX”

TeraTerm Terminal Emulator
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Step 3,
It shows USB Serial Device “COMXx" at Device Manager / PC Windows:

X : depends on your PC's environment

M Device Manager - [m} X

File Action View Help
e« mBmPE
4 Batteries
© Bluetooth
B8 Computer
wm Disk drives
Il Display adapters

§ Ellisys protocol analyzers

[ Human Interface Devices

=8 IDE ATA/ATAPI controllers

2 Imaging devices

= Intel(R) Dynamic Platform and Thermal Framework
& Jungo Connectivity

@ Network adapters
B Portable Devices
v @@ Ports (COM & LPT)
W Communications Port (COM1)
@ ECP Printer Port (LPT1)

ak COCLART Pog (O
B Senal Port (COMY

7 Print queues

= Printers

[ Processors
B Sofrwars Amic -~

@ New connected
Device

Communicate via this Serial device (EX. By TeraTerm @115200,N81).

Step 4,
Execute the command “backup /dev/sda1” and “y”, this command will force Matrix-

700/710/713 to boot again to start the backup process.

# backup /dev/sda1
Backup to /dev/sda1, Sure?(y/n)

The READY LED will be blinking during the backup process
This process may take 20~30 minutes
USB/serial console is NOT accessible during the backup process

v,
- -
I’.‘

)

-

“Ready”™ LED in green

WATIE

After completed above steps, the Matrix-700/710/713 will automatically reboot again
when the backup process is finished.
Remove the USB drive and keep it properly as the golden copy.

]
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30. Restore the “File System” of Matrix-700/710/713

The following information shows how to restore to factory default:

Step 1,
Insert the golden copy USB drive. Let’s say the USB drive maps to /dev/sda1.

Step 2,

Power-on Matrix-700/710/713 (“Ready” LED in green)

After system ready (“Ready” LED turns to yellow)

Connect the Matrix-700/710/713’s USB/serial console to a PC

e aal

f By

mMATRIX

USB Congble

- —

Rl p—

TeraTerm Terminal Emulator
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Step 3,
It shows USB Serial Device “COMXx" at Device Manager / PC Windows:
X : depends on your PC’s environment

A Device Manager = o \(
File Action View Help

e m Em B

W Duplay adapters
§ Elisys protocol analyzers
4 Human Interface Devices
“8 IDE ATA/ATAP! controliers
2 Imaging devices
= Intei(R) Dynamic Platform and Thermal Framework
@ Jungo Connectivity
= Keyboards
@ Mice snd other pointing devices
3 Monitors
@ Network adapters
B Ponable Devices
v i Ports (COM & LPT)
@ Communications Port (COM1)
@ ECP Prntes Port (LPTT)
g1 o

ak LD ELBod COn
@ USB Serial Device (COMT)
W USE Senal b o] %

il Port [

@ New connected
Device

Communicate via this Serial device (EX. By TeraTerm @115200,N81).

Step 4,
Execute the command “restore /dev/sda1” and “y”, this command will force Matrix-

700/710/713 to boot again to start the restore process.

# restore /dev/sda1
Restore from /dev/sda1, Sure?(y/n)

The READY LED will be blinking during the restore process,
This process may take 20~30minutes
USB/serial console is NOT accessible during the restore process.

AT

After completed above steps, the Matrix-700/710/713 will automatically reboot again
when the restore process is finished.
Remove the USB drive.
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